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Introduction

GME makes available an API (Application Programming Interface) service to enable users to download the market results
published on its website.

The use of the service requires credentials (username and password) that may be obtained from GME by filling in a
dedicated form.

This document describes the procedure to request a user account for accessing the service, and examples of use of the
service.

All the information concerning the APl service is available on the dedicated page of GME’s website at the following link:

https://www.mercatoelettrico.org/en-us/Home/APIService
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1. Request of credentials

To request the credentials for accessing GME’s API service, the applicant must fill in the registration form available at
the following address:

https://api.mercatoelettrico.org/users/RegistrationForm/RegistrationRequest

If the applicant represents a “persona giuridica” (e.g., company, organisation, etc.), he/she should select the
corresponding option and complete the additional fields concerning the “Dichiarazione sostitutiva di certificazione”
(Self-Certification) pursuant to Decree of the President of the Republic no. 445/00 (hereafter DPR 445/00), certifying
his/her powers of representation.

N.B.: If the legal representative of the organisation is not an EU citizen, he/she should submit equivalent documents
certifying his/her powers of representation (e.g. extract of report of registration of the organisation with the local Board
of Trade or copy of notarised power of attorney).

(Signature)

Legal Representative

DECLARATION OF POWERS OF REPRESENTATION

SELF-CERTIFICATION

{under Decree of the President of the Republic no. 445 of 28 December 2000, hereinafter referred to as "DPR 445/007)

I, the undersigned

born in

After completing the form and entering the Captcha correctly, click on the “conferma” (confirm) button.
- -
’ * - < ey |
- L

Enter the code Confirm

The system will display a .zip file containing one or two pdf documents (“TERMS OF USE” + possible Self-Certification
pursuant to DPR 445/00) that must be digitally signed and sent by certified e-mail to GME’s certified e-mail address:
gme@pec.mercatoelettrico.org.
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If the applicant has no digital signature certificate, he/she must sign the above-mentioned documents in handwritten
form and submit them together with a copy of a valid identity document.

If the applicant has no certified e-mail address, he/she must submit the documents (signed digitally or in handwritten
form together with a copy of a valid identity document) to GME’s dedicated e-mail address:
posta.gme@mercatoelettrico.org.

After receiving the documents and verifying their regularity, GME will send an e-mail to the user with the temporary
access credentials.
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2. Password change

The temporary password received from GME upon registration cannot be used for access to the API service. The user
should change it by connecting to the portal at the following address: https://api.mercatoelettrico.org/users/

After the first access, the user may change his/her temporary password by specifying a new one (consisting of at least
12 characters and including at least one digit, one uppercase letter, one lowercase letter, and one special character).

The new password will be valid for 6 months, after which the user will have to change it again by accessing the same
portal.
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3. Password recovery

If the user forgets his/her password for access to the API service, he/she may autonomously create a new one by
accessing the portal https://api.mercatoelettrico.org/users/ and clicking on the “Recupero credenziali” (recovery of

credentials) button.

The system will display a form where the user must enter the username provided by GME and the e-mail address

GME

Gestore
Mercati
Energetici

specified upon registration.

Compile the fields for password reset

Username

b e 3Q0

Enter the code

New CAPTCHA
e L eror

By clicking on the “Conferma” (confirm) button, the user will receive a new e-mail with the link to create a new

password.
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4. Procedure for using the API service

This chapter describes the general procedure for using the API service provided by GME, giving an overview of its main
access options, and a specific example of use through the TalendAPI plugin available in the Chrome browser.

The API service enables to download the results of GME’s markets via HTTP requests, by using JSON data exchange
formats.

A complete description of the data queries and formats to be submitted is given in the API Service Technical Guide
available at this link.

The endpoint made available for using the service is: https://api.mercatoelettrico.org/request/api/vl/.

Access methods may vary depending on user requirements and the operating environment:

e customised applications: through the direct integration of API calls into newly developed or existing
management software tools (GME does not provide already implemented libraries or tools);

e test or analysis tools: using dedicated REST clients (e.g. cURL or similar) making it possible to submit queries
and view responses instantly, or web browser plugins (e.g. TalendAPI).
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4.1 Example of use of the API service

The following is an example of using the service directly in the Chrome browser via the TalendAPI plugin.

As a first step, log into the system with the /Auth method:

t ] @ Y T Requests Scenarios (L] @ Help @ v

METHOD SCHEME / HOST [ " PORT ] [ PATH [ "?" QUERY ]|

POST A4 @ https://api.mercatoelettrico.org/request/api/v1/Auth

length: 52 byte(s)
» QUERY PARAMETERS

HEADERS @ |4 Fom~ 4« » Bopy@ Text +
1{

Content-Type : | application/json X 2 "login": "MyUserName",
3 "password": "MyPasswordl23"
4!}

+ Addheader | & Add authorization juf

v

Q@Top ©@Bottom @Collapse E3Open Ey2Request Copy & Download

If the authentication is not successful, you will receive a negative response and the related reason:

Response Cache Detected - Elapsed Time: 5.15
401
HEADERS - pretty + < » BODY pretty +
content-type: application/json; charset=utf-8 v{
server: Microsoft-115/10.0 success: false,
X-powered-by: ASP.NET token: "
: 5
date: Thu, 05 Jun 2025 12:34:18 GMT -1s .
reason: “Invalid user"

}
» COMPLETE REQUEST HEADERS

lines nums 2] copy length 52 bytes

If the authentication is successful, the response will contain the JWT token to be used in subsequent data queries:

Res ponse Cache Detected - Elapsed Time: 388ms
200

HEADERS @ pretty v« » Bopy @ pretty «
content-type: application/json; charset=utf-8 = r

server: Microsoft-115/10.0 -success: true,

X-powered-by: ASP.NET token: "eyJhbGeiOilIUzUxMiIsInR5cCIGIKPXVCIS.eyIIZCI6IIIiLCTIpe3MioilodHRWOLBYbGS:
date: Thu, @5 Jun 2025 12:35:23 GMT -1s

reason: null

N
}

<« GEEEEE——— »
fines nums 1 copy length: 503 bytes

» COMPLETE REQUEST HEADERS

After obtaining the authentication token, you may enter data queries with the RequestData method?:

1 Important: enter the token into the Authorization header with the “Bearer” value followed by a space and then the token value.
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RequestData

Save v

METHOD SCHEME // HOST [ PORT ] [ PATH [ "?" QUERY ]|

POST v @ https://api.mercatoelettrico.org/request/api/v1/RequestData

length: 59 byte(s)
» QUERY PARAMETERS

HEADERS @ 12 Fom~ ¢« » Bopy?

Text v

19

Content-Type : | application/json x 2
3 "MGP",

Authorization  : | Bearer eyJhbGciOiJlUzUxMilsInRE  x & 4 _Zonalvolumes™,
5 "2825@8501",
6 "intervalEnd": "28250581",

+ Add header £ Add authorization of 7 "attributes” : {}

8}

Q@Top ©Bottom & Collapse Open B2Request (Copy & Download

If the request is not successful, the resultRequest field will show the cause of the problem:

Response Cache Detected - Elapsed Time: 544ms
412

HEADERS @ pretty~ <« » oDy ?@ pretty ~
content-type: application/json; charset=utf-8 {

server: Microsoft-115/10.0 requestId: "271",

x-powered-by: ASP.NET formatType: ".json.zip",

date: Thu, ©5 Jun 2025 15:10:39 GMT

resultRequest: "INVALID_INPUT - Parameter IntervalStart is grather than IntervalEnd"

contentResponse: null
» COMPLETE REQUEST HEADERS

4 EEEEEEEEEEEEEEEE——— ¥
lines nums €3] copy length: 153 bytes

If the request is successful, you will receive a positive response with the requested data:

Response Cache Detected - Elapsed Time: 2.365
200
HEADERs @ prety ~ 4 » Boby @ pretty +
content-type: application/json; charset=utf-8 - {
server: Microsoft-11S/10.0 requestId: "270"
: »
x-powered-by: ASP.NET formatType: ".json.zip",
date: Thu, 05 Jun 2025 13:21:27 GMT

resultRequest: null,

contentResponse: "UEsDBBQAAAAIAK16xVpsVkISWxEAAIVOAAATAAAAZGFOYS5qc29uxZ1Ljx23E
» COMPLETE REQUEST HEADERS

4@ »
lines nums €] copy length: 6 kilobytes

The data is contained in the value of the “contentResponse” field, which represents a .zip file in Base64 encoding.
To convert the string into a file, you may use any decoding tool. The following example uses Notepad++.
Open the editor and paste the contentResponse value to a new document.

After selecting it, choose the Plugins -> MIME Tools -> Base64 Decode menu.
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L_f *new 1 - Notepad++
File Edit Search View Encoding Language Settings Tools Macro Run  Plugins Window ?

AE® ﬁ@@|ﬁm®|@e|ﬂ%| % %|Eaa|f-_-' 1~ MIME Tools > Base64 Encode
E new 1 # HE IE [E [E Converter > Base64 Encode with padding
1 IUESDBBQARBAIAKI6XVDSV]{J9WX.EAAJV9AABJAMAZGFOYS5qCZQuXZle] NppExport 5 Base64 Encode with Unix EOL

Open Plugins Folder... BaseGalfncadelbylline

( Base64 Decode

Base64 Decode strict

Base64 Decode by line

Quoted-printable Encode
Quoted-printable Decode

URL Encode (RFC1738)

URL Encode (RFC1738) by line
URL Encode (Extended)

URL Encode (Extended) by line
URL Encode (Full)

URL Encode (Full) by line

URL Decode

SAML Decode

About

After decoding the file, you may save it with a .zip extension:
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g’ *new 1 - Notepad++

File Edit Search View Encoding Language Settings Tools Macro Run Plugins Window ?
COEB S el PR e el e REI= 1 - R 6 e e w5
||“I S A
Bnew1 » B J avens x

5 < v « test > ProvaAPl... v C Cerca in ProvaAPIGME o]
4 4 .
5 <Prax<faaee Organizza ~ Nuova cartella = = o
6 1xD4 BETESS ~
7 Z( Annamaria Nome Ultima modifica
9 8[B S x FA ] N

10 S :DoMEFDH Visti iran Nessun elemento corrisponde ai criteri di ricerca.

11 B/

12 [

13

14 ) E > @ OneDrive

15

75 > [ Questo PC

:; > t Rete

20

21

22 Nome file: ME_ZonalVolumes.zip| w

ii Salva come: Normal text file (*.txt) ~

26

27

28

~ Nascondi cartelle @ Append extension Annulla
The .zip file contains a data.json file that you may view via Excel:
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File Home Inserisci  Layoutdipagina Formule Dati Revisione Visualizza Automatizze
f:‘ (& &~ D [H |2l [7]A Y NZ
TN ~ & == |- ALz Z
Recupera e Lo Aggiorna Organizzaz Azioni zl Ordina Filtro
| dativ | ES [B tuttiv [B A \& Avanza
D Da file > [E! Da excel cartella di lavoro Ordina e filtra
A
I:% Da database > I:Irzl Da testo/CSV y : ;
J N
5 & Da Azure > Da XML
3
4 é Da Power Platform > Da JSON Da JSON
- — Importa i dati da un file JSON.
6 [z) Da servizi online > lp_Dl? Da PDF
7
8 I:EL‘ Da altre origini > D Da cartella
9| (|
19 B i > DD rtella di SharePoint
il Combina query a cartella di areroin
5 EH s
12 @ Awvia |'editor di Power Query...
13]
14 [«E Impostazioni origine dati...
15 Opzioni query
1
17

The system will display a window, where you have to press the “Con la tabella” (with the table) button,

il e
Home Trasforma
¥
E=
Conla Mantieni  Rimuovi
tabella  elementi = elementi
Converti Gestisci elementi
Query [1] <
D data
1
2
3

and then expand the columns:
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Aggiungi colgas

Elenco

Record
Record

Record

Strumenti per gli elenchi

data - Editor di Power Query

Wsualizza Trasforma
YZO
Statistiche
Ordina Elenco numerico
ﬁc = Json.Document(File.Contents("C:\test\ProvaAPIGME\data.json"))
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Query [1] < fx = Table.FromList(Origine, S
2 data
. | 155 Columni
1
ecord
3 |Regord
Rec®rd
5 |Record
6 |Record
7 |Record
8 |Record
9 |Record
10 | Record

Finally, click on the “Chiudi e carica” (close and load) button.

M| - = |data- Editor di Power Query

Home Trasforma Aggiungi colonna Visualizza

for 2o ?@Proprieté L‘ |J Y, X ‘%i ¥ Tipo di dati: Qualsiasi ~ =
& L3 B x B85 ; h = =

[E‘r Editor avanzato @ Usa la prima riga come intestazione ~

Chiudi e Scegli  Rimuovi  Mantieni Rimuovi Dividi  Raggruppa , L . Combina ¢
carica™  an —colonne~™  righe~ righe~ colonna ~ per 52 Sostituisci valori - pal
Chiudi Gestisci colonne Riduci righe Ordina Trasforma Pz
Query [1] < fx = Table.ExpandRecordColumn(#"Conversione in tabella”, "Columnl”, {"FlowDate™, ﬂ
M data

™. 155 Columni.FlowDate E 155 Columni.Hour E 35 Columnil.Period lz‘l 55 Columni.Market E

1 |20250501 1 0 MGP
T 20250501 2 0 MGP ~

T 20250501 3 0 MGP

T 20250501 4 0 MGP

k= INICACNT [~ n RACZD
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5. User quotas

GME’s API service manages queries through a quota system. Each user is limited to a certain number of connections per
minute and per hour, as well as a maximum number of data items that can be downloaded within those timeframes.
Once the maximum values are reached, the user must wait until the end of the current minute or hour before submitting
a new query.

The consumed quotas and the maximum available limits can be viewed using the /GetMyQuotas method.

To ensure a constantly efficient service, GME reserves the right to modify quota limits at any time and without prior
notice.
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